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Preface

Preface

This document describes how to integrate Oracle NoSQL Database with Oracle SQL
Developer.

Documentation Accessibility

For information about Oracle's commitment to accessibility, visit the Oracle
Accessibility Program website at http://www.oracle.com/pls/topic/lookup?
ctx=acc&id=docacc.

Accessible Access to Oracle Support

Oracle customers who have purchased support have access to electronic support
through My Oracle Support. For information, visit http://www.oracle.com/pls/topic/
lookup?ctx=acc&id=info Or visit http://www.oracle.com/pls/topic/lookup?
ctx=accé&id=trs if you are hearing impaired.

Conventions

The following text conventions are used in this document:

Convention Meaning

boldface Boldface type indicates graphical user interface elements associated
with an action, or terms defined in text or the glossary.

italic Italic type indicates book titles, emphasis, or placeholder variables for
which you supply particular values.

monospace Monospace type indicates commands within a paragraph, URLs, code
in examples, text that appears on the screen, or text that you enter.
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Introduction to Integrating Oracle NoSQL
Database with Oracle SQL Developer

This chapter provides information on how to install and use Oracle SQL Developer to develop
and view Oracle NoSQL Database stores and data.

Oracle SQL Developer is an integrated development environment designed to simplify the
development and management of Oracle Database.

# Note:

Oracle SQL Developer does not support Oracle NoSQL Database table and data
creation, modification, and deletion.

¢ See Also:

e "Oracle NoSQL Database"

e "Prerequisites"

e "Oracle SQL Developer Installation”

e "Viewing Oracle NoSQL Database Using Oracle SQL Developer"

e "Exploring Oracle NoSQL Database Store Using Oracle SQL Developer"

Prerequisites

Following are the prerequisites to install Oracle SQL Developer 4.2 in an Oracle Unix
environment to use with Oracle NoSQL Database.

e Oracle Linux Operating System
e JDK 8 or above
e Oracle NoSQL Database

e Oracle SQL Developer 4.2 or greater

Oracle SQL Developer Installation

This section describes how to install Oracle SQL Developer.

To install Oracle SQL Developer and the . jar file necessary for it to connect to an Oracle
NoSQL Database store, perform the following tasks:
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Chapter 1
Oracle SQL Developer Installation

Download and install JDK 8 to your Oracle Linux Operating System environment.
For more information, see Download Oracle SQL Developer and JDK 8.

# Note:

To test whether you already have JDK 8 installed, use:

java -version

Install Oracle SQL Developer by following the steps below:
a. Download Oracle SQL Developer.

b. Install Oracle SQL Developer.

c. Start Oracle SQL Developer to verify installation.

< Note:

The details about client/server version can be found here at Oracle
Technology Network.

¢ See Also:

e "Download Oracle SQL Developer and JDK 8"
e "Install Oracle SQL Developer"
e "Start Oracle SQL Developer to Verify Installation”
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Viewing Oracle NoSQL Database Using
Oracle SQL Developer

To use Oracle SQL Developer, you must create a connection to the Oracle NoSQL Database
store.

For information about security considerations for NoSQL data stores, see Installation
Configuration Parameters in the Administrator's Guide.

To create a connection to the Oracle NoSQL Database, perform the following steps:
1. Confirm that a kvstore is up and running. In the examples below, kvlite is used. To

start kvlite, enter the following command in a terminal:

java -Xmx64m -Xms64m -jar SKVHOME/lib/kvstore.jar kvlite

KVHOME refers to the directory where you have installed Oracle NoSQL Database. This
command assumes that Oracle NoSQL Database is installed in the local machine.

2. Asingle node kvstore instance is created and opened using the default parameter
values. Do not close this terminal as it shuts down kvlite.

3. To verify that kv1ite is running, enter the following command in a new terminal:

java -Xmx64m -Xms64m -jar SKVHOME/lib/kvstore.jar ping -host localhost -
port 5000

4. The output shows that a kvstore is up and running successfully.

5. Open SQL Developer.

# Note:

By default, Oracle NoSQL Database stores are installed with security being
enabled, but you must check with your store's administrator to find out whether your
store was installed with or without security.

Connecting to a Secure Oracle NoSQL Database Store

To connect to a secure Oracle NoSQL Database store, follow the steps below:

1. Obtain the SSL security files (client.trust and client.security) from your
store's administrator that is used by an Oracle NoSQL Database client to connect to the
store. This file was generated during the installation process of your secured store. Place
these files on your local hard drive.

2. Open SQL Developer and click + in the Connections tab.
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Chapter 2
Connecting to a Secure Oracle NoSQL Database Store

Figure 2-1 Connections Tab

Connections -

RY S

Choose New Oracle NoSQL Connection.

Figure 2-2 New Oracle NoSQL Connection

Connections =

R Y S

New Connection...

New Oracle NoSQL Connection...

New Cloud Connection...

Enter your Connection Name, for example Oracle NoSQL Connection, and also
the Username and Password that you use to log in to the Oracle NoSQL
Database store.

Select SSL in the Security section. Provide the paths to the client.trust
and client.security files that you placed locally on your machine. Note that
after configuring and starting the KVStore successfully, you can see that the
security directory is created and the security files are available to use. To know
more details about the security files and the installation, contact your Oracle
NoSQL Database administrator. See Security Configuration in the Security Guide.

Figure 2-3 Security Installation

Store

Username: |admin

Password: Ico-ooooooo.o

|
|
|
Store: Ikvstore ]

Hosts: Ilocalhost:SOOO

Security

SSL:

TrustStore: |_u0lfnosql,‘kvroot,*security{client.trust | Browse

Oracle Wallet: [uDlfnosql,Fkvroot,fsecurithser’.waIIet | Browse

Properties File: [JCil{ncsqI,‘kvrcct!securitv,’user.securiw | Browse
Help OK Cancel
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Chapter 2
Connecting to a Non-Secure Oracle NoSQL Database Store

6. The new secured connection is now listed in the Connections tab.

Figure 2-4 Listed NoSQL Connection

a Connections
-3 KVHost
a Oracle NoSQL Connections

8= WNoSQL_Connection

Connecting to a Non-Secure Oracle NoSQL Database Store

To connect to a non-secure Oracle NoSQL Database store, perform the following steps:

1. Open SQL Developer and click + in the Connections tab.

Figure 2-5 Connections Tab

Connections [=]

TRY®

2. Choose New Oracle NoSQL Connection.

Figure 2-6 New Oracle NoSQL Connection

Connections [=]

Y&

New Connection...

New Oracle NoSQL Connection...
New Cloud Connection...

3. Provide a name for the new connection. Key in the values for Hosts and Store, and
click Ox.
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Connecting to a Non-Secure Oracle NoSQL Database Store

Figure 2-7 Provide Name and Enter Values for New Connection

= New Oracle NosSQL Connection >

Connection Name: |NoSQL_Connectlon |

Store

Username: |

Password: |

Hosts: |I0calhosl:5000

Store: [kvstore

Security

SSL: (I

|
Oracle Wallet: I ] Browse
[

Properties File:

Help ( oK | Cancel

4. The new connection is now listed in the Connections tab.

Figure 2-8 Listed NoSQL Connection

a Connections

& KVHost

a Oracle NoSQL Connections
Eia NoSQL_Connection
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Exploring Oracle NoSQL Database Store
Using Oracle SQL Developer

ORACLE

Oracle SQL Developer provides a read-only interface to Oracle NoSQL Database stores. It
does not currently support table creation, data creation, modification, or deletion.

See the following:

» To create, modify, or delete tables, execute the appropriate DDL statements against the
store, see Creating a table for more examples.

* To load data into your table(s), modify it, or delete the data, see Inserting, Modifying, and
Deleting Data for more examples.

Follow the steps below to view the tables and table data in your store:

1. Click the + under Oracle NoSQL Connection to view the tables currently available in
the store.

2. Click each table to view its child tables, if any have been created for it.

3. Expand the accounts table. You should see a nested table listed for this table.

Figure 3-1 Accounts Table

L]
‘)Connections

+-RYD
a Connections
@ QOracle NoSQL Connections
= @ NosQL_Connection
-4 products
=-EH user
=-EH accounts
@ E3 transaction
#-F5 ebcard
@5 redemption
w Cloud Connections

4. To view the schema definition for a table, double-click the products table.
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Figure 3-2 Products Table

= @ stapage ] & procuces - [

Connections

+ - m Y % Culumns; Data | Indexes | Child Tables | Details | Model
aConnec\ions Ll “
@ oracle NosQL Connections { Column Name | Data Type [{} Nulable |{} Default Value [} Column 1D [ Comment
Ea NoSQL_Connection 1 prodCat STRING 2] 1
=@ g’"’ 2 prodid STRING ] 2
B = ::fumlk 3 prodName STRING = 3
&-B8 accounts 4 stock INTEGER =) 4
. @~ transaction S price INTEGER 3] 5
- ebcard
(&3 redemption
& Cloud Connections

5. Click Columns to view Column Name, Data Type, and value specification.

Figure 3-3 Columns Tab

olumns/ Data | Indexes | Child Tables | Details | Model

@

{} Column Name ‘5} Data Type ‘{} Mullable |$ Default Value 15} Column ID |€t Commentl

1 prodCat STRING O 1
2 prodid STRING O 2
3 prodName STRING 3
4 stock INTEGER 4
S price INTEGER 5
6. Click Data to view table data.
Figure 3-4 View Table Data
Columns Data Indexes | Child Tables | Details | Model
{} prodCat I{} prodld G prodMame 0 stock 0 price
1 camera 1 nikon 12 145
2 electronics 1 philips mp3 player 15 79
3 mobiles 1 nokia 1100 4 67
4 electronics 2 dry iron 2 55
S electronics 4 toaster 6 34
6 kitchenware 1 tava 5 15
7 electronics 3 bose speaker 3 150

7.

Click child Tables to view the child tables available for the corresponding

parent table.

ORACLE"
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Figure 3-5 View Child Tables

@ Start Page B user

Columns | Data | Indexes Child Tables Details | Model

!

it Table Name |{} Full Table Name |4} Version |} Description

1 accounts user.accounts 1

2 ebcard user.ebcard 1

3 redemption user.redemption 1
# Note:

* You can query (read) Oracle NoSQL Database data while simultaneously
accessing an Oracle Database.

* If your Oracle SQL Developer is of a version earlier than 4.2, and you receive
incompatibility issues due to discrepancy in different version numbers across

NoSQL client and NoSQL server, ensure to import the supporting Oracle
NoSQL JAR files to the Oracle SQL Developer library to view the Oracle
NoSQL Database tables and the corresponding data successfully.

# See Also:

e "Table Data Definition Language Overview"
e "Getting Started with Oracle NoSQL Database Tables"
e "Admin Command Line Reference (CLI) - put table"

e "Introduction to Integrating Oracle NoSQL Database with Oracle SQL
Developer"
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Upgrading Oracle NoSQL Database Support
via Check for Updates

You can upgrade the NoSQL Server by using the SQL Developer Check for Updates
feature.

1. Ensure that you have installed Oracle SQL Developer. See Oracle SQL Developer
Installation.

The following screen is displayed.

Figure 4-1 Start Page

F
1 Oracie NeSGL Conesctions.

o Datshase Schema Senae Connections a
Cet Staried Commurniby
Featured Tatoriaks Featured Onfine Demonstrations
‘What's Hew Optimizer Acoess Paths Datshase Copy
Rebease Mol 501 Tuming Advisor Reporting Features
Documentation Working with Tuning Utilitios Orace Data Pamp Featune
SOL Developer on OTH
i - B All Online Tutorials All Online Demonstrations
Fepars.
& A reperts
g3 Anakmc View Reports
& @ Da Gictionary Repors
N o ad T e e i [+#] show an Startup Comyrght & 2005, 2017, Grack andior fs affileies, All nghis resened,
= 2 OLAF Reports
@ g2 TimesTen Raperts
(i User Defined Reports:

2. Choose Help-> Check for Updates.
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3.

Figure 4-2 Check for Updates
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Choose Add. The Update Center window is displayed.

Figure 4-3 Update Center Window

@ Oracle SQL Developer : Start Page

ORACLE
_ £ 0L DEVELGRER

8 Ehect for Updates - Step 1 o1

senrch for ugdates pubished i Updane Centers, or insal i update from a bundle o have alrendy devalnsad,

g 7 Eutomascat chack 65 epciies M Micty

hirykind] () Search Updale Certers: Progry Sattingi. .

i) [¥] Oracke STL Develper ..
hitp:/ e aracke, complsiazenydotols/usege/chy R

| termal SQL Developer Updates fde
hetp . fraptar arack conp. oy b e/ updateaiapoata sl
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ig I bt e, o i Loy oS dacuma sis e el

Ly i [ vhird Party SO0 Dewalopor Extensions

{5 Al Regens et v, rT . D o sl e 3 enl

- Ak View Reparts e

(e Dt Decen by Rt

g5 Dats Modelker Reparts
2 OLAP Reparty

& @ TimesTen Reperis
G2 e Deingd REpems
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Enter a Name, for example Oracle NoSQL Updates, and browse to the
update.xmnl file. To navigate to the updates.xml file, go to Oracle NoSQL
Database in Oracle Technology Network, and choose the Downloads tab in the
Download SQLDeveloper update.xml section.
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Figure 4-4 Enter Details of the Update Center
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5. Choose Next (it checks for Internal SQL Developer Updates).

6. Select Oracle NoSQL Database and choose Next.

Figure 4-5 Select Updates to Install

|
Select updates to instal rmﬁ
Avalable Updates
g, Source
i) Updates 2 amch [l ghow Upgrades Only | Oracle NoSQL Database
"T* | 12cR2.4.4.6
T 12.2.1.160.1335
W DLETETA
Orade NoSQL Database support for
SQL Developer
Created By
Orade
Visit Homepage
Currently Installed Version
12.2.1.158.1652

7. Selectthe I Agree option in the License Agreement screen. You see that Oracle
NoSQL Database is installed under Upgrades. Choose Finish.
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4

Choose Yes to the window prompt, which asks for a restart of SQL Developer, to

complete the installation steps.

This step completes the installation process.

Figure 4-6 Restart SQL Developer

Oracle NoSQL Database.

Figure 4-7 Extensions
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Choose Help -> About and then choose the Extensions tab to see the installed

Q, onsd x

Name f Identifier Version Status

Orade NoSQL Database 12(R2.4.4.6 orade.sqldeveloper.onsd  12.2.1.160.1439 Fully Loaded

-~

Uninstalling Updates
To uninstall the updates for Oracle NoSQL Database, choose Tools ->

Features. Gotothe Installed Updates tab and select Oracle NoSQL
Database and choose Uninstall. This uninstalls the updates.

ORACLE"
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Figure 4-8 Uninstall Update

Features | Installed Updates

Q, Search

=~ ([ Database
.E'

ey, Orade NoSOL Database 12dR2.4.4.6

Collapse Al

" Note:

i Check for Updates ~

To remove one or more instalad updates, select the bundles and dick Uninstall,

Oracle NoSQL Database 12cR2.4.4.6
12.2.1,160,1439
Orade NoSQL Database support for SQL Developer

Created By

Orade

Visit Homepage

Currently Installed Version
12.2.1.160.1439

This will only uninstall the Oracle NoSQL Database extension that was added and
not the base version that comes with SQL Developer.
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